Tech Note 117
Using the InTouch 7.0 ActiveX Container

All Tech Notes and KBCD documents and software are provided "as is" without warranty of any kind. See the Terms of Use for more information.
Topic#: 000725
Created: October 1998
Note This Tech Note requires that you have Internet Explorer 4.0 and either Windows 95 service pack 1 or Windows NT 4.0 service pack 3 installed on your computer.

This Tech Note shows how to use the Wonderware® InTouch™ version 7.0 ActiveX container. It demonstrates how to install and create an instance of the Microsoft Web Browser ActiveX Control in an InTouch application. This Tech Note covers the following: 

· the control name scheme used in InTouch 7.0;

· using control properties, methods, and events;

· using event parameters.

Note It is beyond the resources of Wonderware Technical Support to know the detailed specification of every ActiveX control. If you require assistance troubleshooting an InTouch application that uses a third-party ActiveX control, you must first contact Wonderware Technical Support and open a case. Next, you will need to provide the following: a copy of the InTouch application that uses the control, a complete set of the ActiveX control’s file(s), the installation software or instructions on how to register the control, and a copy of the OCX.INI file (which is located in the InTouch directory). Note that Wonderware is not responsible for troubleshooting the source code for misbehaving or improperly written ActiveX controls. See Tech Note 96, titled Using ActiveX Controls in InTouch 7.0 for more information on how to develop ActiveX controls for use with InTouch 7.0.

Installing An ActiveX Control in InTouch

Follow these steps to install an instance of the Microsoft Web Browser ActiveX Control in an InTouch application: 

1. Open InTouch and create a new application.

2. Launch WindowMaker and then select Special/Configure/Wizard/ActiveX Installation. Click the ActiveX Control Installation tab.


3. Next, scroll through the Available ActiveX controls list, select “Microsoft Web Browser” and click Install. After you have successfully installed the Web Browser control into WindowMaker, the control name should appear in the Installed ActiveX controls list. Click Close.

Note If you could not complete this step because “Microsoft Web Browser” did not appear in the Available ActiveX controls list, then look in the Installed ActiveX controls list to see if it had been previously installed. Also, make sure that Microsoft Internet Explorer 4.0 is installed on your computer.

Creating an Instance of the ActiveX Control in Your Application

ActiveX controls can be placed anywhere on an InTouch application window. Once a control has been placed on a window, it becomes an instance of that control. Follow these steps to create an instance of the Microsoft Web Browser ActiveX control in your InTouch application: 

1. Create a new window and then change the background to a color other than light grey.

2. Resize the window, making it as large as possible.

3. Click on the Wizard tool (it looks like a wizard hat). From the ActiveX controls, select Explorer, which is the wizard name for the Web Browser, and then click OK.
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4. Paste the Internet Explorer object on your new window. It will appear as a light grey rectangle. Increase the object’s size, leaving enough room at either the top or bottom of your window for a few push buttons we will create later. This area will be referred to later as the control bar.

5. Create two memory integer tags called ITExplorerProgress and ITExplorerProgressMax. You can use the default values to define these tags.

The ActiveX Control Name

To view or modify the ActiveX control name, either double-click the Internet Explorer ActiveX object or right-click on it and select Properties. In the Explorer1 Properties dialog box, click the Control Name tab. 
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By default, the Control Name is determined by the ProgID for that control. ProgIDs are names that are entered into the system registry when ActiveX controls are installed on a computer. When an instance of that control is placed in an InTouch application, the control's ProgID is obtained from the system registry and an index number is appended to it, resulting in a Control Name, such as Explorer1. 

· A new instance of a control is created and given a unique name under the following circumstances:

· On the Edit menu, selecting Duplicate
· On the Edit menu, selecting Cut or Copy and then Paste
· Clicking Undo and then Redo
· On the File menu, selecting Save Window As
· Importing a window that contains a control

Changing the Control Name

It is best not to change the names of ActiveX controls; however, there are special cases where this may be necessary. For example, say that you have already written a number of scripts that rely on the Control Name Explorer1. For some reason, you have to delete the control itself. Later, you create a new instance of the control. In order for the existing scripts to work with this new control, you must rename the new control from Explorer2 to Explorer1.

ActiveX controls must have unique names If you edit the Control Name and then click the OK or Apply button, the name will be checked against a table of existing Control Names. If the name does not already exist in the table, the name of the control will be changed and saved. If the name already exists, an error message will appear and you will not be allowed to exit the dialog box until a unique Control Name is selected. 

The ActiveX Control Properties

To view or modify the ActiveX control properties, either double-click the Internet Explorer ActiveX object or right-click on it and select Properties. In the Explorer1 Properties dialog box, click the Properties tab. 
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The programmer that writes an ActiveX control determines its properties, methods, and events; therefore, the properties vary between controls. ActiveX control properties can either be hidden or exposed. Although there are many controls available on the Internet that have no exposed properties, the controls that are developed with Microsoft Visual Basic or Visual C++ tend to have some exposed properties, such as size (height and width in pixels), location, and the background and foreground colors. When InTouch loads an ActiveX control, the control tells InTouch to populate the property sheet with a list of properties that should be exposed. 

The Properties tab contains three columns: property column, range column, and associated tag column.

Property Column

The name of the property is listed under the property column. 

Range Column

The range column provides a way of “seeing” a list of values that are possible for each property. Note that it is not possible to change the value that is selected in the range column. 

The dialog box above shows the range for the property ReadyState. A ReadyState value of 1 is probably used by Microsoft to animate the comet swirling around the logo of the earth with a superimposed lowercase e to tell the user that a page is loading. Once a page is done loading, ReadyState is set to 4, or complete. 

The range column can be used to determine the type of InTouch tagname that is required for each property. For example, the tag we associate with ReadyState will need to be an integer type so that it can store the values 0, 1, 2, 3, and 4.

Associated Tag Column

In the Associated tag column, you can select a tag that already exists or you can create a new tag. To select a tag that already exists, double-click the space in the Associated tag column or click the ellipsis button to choose a tag from the tag browser. 

Note Remote Tagname References may also be associated with ActiveX properties.

Associating a New Tag With a Property

Follow these steps to create a new tag called ITExplorerstate and associate it with the ReadyState property: 

1. Type the name ITExplorerstate under the Associated tag column for the ReadyState property. Since the tag does not exist yet, you will be prompted to create it. 

2. In the Tagname Dictionary dialog box, save ITExplorerstate as a memory integer tag since it will store analog values. 
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Association Symbols

After the ITExplorerstate tag has been saved, an association symbol will appear. The association symbol is a blue arrow that determines what type of link exists between the property and the associated InTouch tagname. 

There are two possible association symbols in this case. The first symbol is an arrowhead pointing to the right with a tiny vertical bar on the left end of it. This symbol means “The ReadyState property will notify the InTouch tagname of changes, but the InTouch tagname cannot change the value of the ReadyState property.” ReadyState is a read-only property so that it cannot be written to. The second symbol is a blank, which is used for troubleshooting purposes. For example, say that you want to temporarily disable the link between the tagname and the property, but you don’t want to forget the name of the tag. You could delete the tagname; however, it would be better to select a blank association symbol to retain the tagname and only break the link. This will also indicate that the tagname is in use so it cannot be deleted from the database. 

The ActiveX Control Events

To view or modify the ActiveX control events, either double-click the Internet Explorer ActiveX object or right-click on it and select Properties. In the Explorer1 Properties dialog box, click the Events tab.
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Events are external user-generated and system-generated messages that the control listens to and processes. Here are some examples of events: 

· Keyboard (keypress, keyascii, and keydown)

· Mouse (click, double-click, and right-click)

· OnChange (property changed, date or time changed, timer expired)

Associating a Script With an Event

InTouch allows you to associate a named script with a particular event. In this example, we will create a script called ExplorerProgressChange and associate it with the event ProgressChange. The ProgressChange event will monitor the time it takes to load a page into the browser control and will be continuously updated while a page is loading. Every time ProgressChange is updated, the ExplorerProgressChange script will be executed.

Follow these two steps to create the ExplorerProgressChange script: 

1. Click in the script column next to the Progress Change event. Type ExplorerProgressChange as the name of the script and click the ellipsis button. 

2. Click OK when the WindowMaker dialog box asks if you want to create a script named “ExplorerProgressChange.”
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Configuring Event Parameters

Events can have event parameters. We will use two event parameters to animate a progress indicator bar that we will add later to the InTouch window. This progress bar will show the percentage of completion for the currently loading window, similar to the progress bar that exists in the actual Internet Explorer 4.0 browser. 

Follow these steps to configure the event parameters: 

1. On the Events tab, under the Script column, double click on the name ExplorerProgressChange to launch the ActiveX Event Scripts dialog box.
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2. Select ActiveX from the Insert menu to launch the ActiveX Control Browser.
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The ActiveX Control Browser is used to select properties, methods, events, and event parameters for use in InTouch scripting. The name of every instance of each ActiveX control in your application will appear in this list.

Note The ActiveX Control Browser may be accessed from every script type in InTouch. However, ThisEvent and ThisControl, which are special-case control names, will only appear when the ActiveX Control Browser is launched from the ActiveX Events Scripts dialog box, as demonstrated in this step. 

Select ThisEvent to see a list of parameters that are possible for the event that was selected on the Events property page when the ActiveX Event Script Editor was launched. The event parameters contain useful information. For example, you may have a keypressed event and you want to know "Okay, so we know a keystroke occurred but which key was pressed?" If this information is important, the developer of the control probably added an event parameter to store the key code. To access this parameter, you would need to select ThisEvent and then select the parameter, which might be called keypressedkeycode. It is of special note that the majority of ActiveX events do not have parameters.

ThisControl is used to write generic references in event scripts that can be reused in any instance of the same control type. When ThisControl is selected, the same list of properties and methods appears as the list for the specific control name, Explorer1. This Tech Note does not cover ThisControl indepth.

From the ActiveX Control Browser, select ThisEvent, select the parameter ProgressChangeProgress and then click Done. This will paste the following string in the ActiveX Scripts editor:

#ThisEvent.ProgressChangeProgress

Complete the script as shown below to animate our progress bar:

ITExplorerProgress = #ThisEvent.ProgressChangeProgress;
ITExplorerProgessMax = #ThisEvent.ProgressChangeProgressMax;

The first line of the script is really just a simple assignment. That is, the tag ITExplorerProgress is being assigned a value from what is on the right side of the assignment operator (=). Every time the ProgressChange event occurs, the current value of ProgressChangeProgress will be stored in a tagname called ITExplorerProgress. 

So an ActiveX scripting reference really has 4 parts. Part 1 is the number sign (#), simply an indicator saying, “I’m an ActiveX scripting reference.” Part 2 is the name of the control. Part 3 is the delimiter character, a period (.), which is used to separate the control name from the last part. Part 4 is the property, method, or event parameter.
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Using ActiveX Methods to Animate the Web Browser

Methods, or functions, can be accessed only through InTouch scripting. Typically, a method is an action that is performed by the ActiveX control. For example, we need our Internet Explorer control to show us different web sites inside the object. This action is called “navigate,” or to put it more succinctly, #Explorer1.Navigate( );. 

We will now add a control section to our browser window. This section will have an Address Bar, Load Progress Indicator, and various navigation buttons, such as Back and Refresh.

Creating the Address Bar

Follow these steps to create a button that can change the URL (Universal Reference Locator) of the Web Browser: 

1. From the Draw Object Toolbar select the button tool.

2. Create a long, narrow button for the user to type in the URL.

3. Change the text on the button to URL.

4. Animate the button with a Touch Link User Input String using the default values. For the tagname, use a memory message tag called URL. 

Next, we need to create a script that will cause the Web Browser to automatically navigate to the URL that the user types into the URL button: 

1. Create a new Data Change Script.

2. Use the URL tag for the Tagname[.field]:. 

3. Enter the one line script body:

4. #Explorer1.Navigate(URL);

If you used Insert/ActiveX Control Browser to paste the navigate method, what you actually saw pasted was:

#Explorer1.Navigate( "String", "Pointer", "Pointer", "Pointer", "Pointer")

Notice there are four pointer data type arguments used here. InTouch supports only discrete (boolean), real (float), integer (long), and message (string) data types. In this case Microsoft has anticipated the use of their control in a container such as ours and does not require arguments 2 through 5 to be included in the calling reference for this method. Therefore, we simply remove them. All that is left is the first argument, a string. This can be a literal string, such as the following:

#Explorer1.Navigate( “http://www.wonderware.com”);

Or it can be a message type tagname containing a string such as the one that we used.

Note A point to consider here is the use of a global script type – Data Change to animate an ActiveX object. Tech Note 96 indicates that ActiveX scripts require that the control be loaded in memory. If the control is not found, an error will appear in runtime. Why then have we used this script? It is a design decision really. Since the URL tagname can change only from this window, we are certain this script will never execute unless the window is already open.

Testing the Web Browser

To test the Web Browser we created, go to Runtime and click on the Address bar. Type a valid URL, such as www.wonderware.com. Internet Explorer 4.0 will automatically add “http://” for you. If you are connected to the Internet, it will open the Wonderware corporate website.

The Web Browser is a functional browser object. Try any of the following: 

· Click on any link in the browser—you are navigating the Internet!

· Drag and drop an HTML, PDF, JPG, or GIF file onto the browser object. It will automatically load the dropped object.

· Change the URL to a file path reference, such as c:\winnt\winnt256.bmp. It will prompt you to open this file directly or download and save it, just as though you were getting the file from the Internet.

Practical Use of the Web Browser

You may use the Web Browser to access intranet help files for plant floor equipment or maintenance schedules. As soon as the documentation department changes these files they will be immediately available to the client terminals on the plant floor. Help files can be designed in either PDF (Adobe Acrobat) or HTML (hypertext markup language) and can include detailed diagrams, flow charts, pictures, videos, and sound. All of these can be called up easily from the Web Browser inside WindowViewer.

Adding More Features to the Web Browser

Here are some additional features you may add to the web browser:

Configuring the Address Bar So It Updates the Address

You may have noticed that as you click on the various website links, the address bar does not automatically update. In fact, it still shows the original address you typed in: www.wonderware.com. To configure the address bar so it updates the address, create a condition script with the condition ITExplorerState = 4 (ITExplorerState was the tag we associated with the property ReadyState). The body of the script should be:

URL = #Explorer1.LocationURL;

Now every time a page is loaded, its URL will be automatically written to our URL tag. Now as you navigate inside the browser, clicking on links and graphics, these URLs will be automatically posted to the address bar.

Adding a Load Progress Indicator Bar

1. We will now use the ProgressChange event script we wrote earlier to animate a load progress indicator bar.

2. Create long skinny rectangle and fill it with the color blue. This will be the load progress indicator bar.

3. Animate it with a Percent Fill Horizontal link. Change the background color to white. The expression field should have the following:

4. ( ITExplorerProgress / ITExplorerProgessMax ) * 100

5. Where ITExplorerProgress and ITExplorerProgressMax are the two tags we created earlier when we wrote the Event Parameter script. 

As a page loads in runtime, the progress bar will gradually fill the rectangle until the page is fully loaded.

Adding Additional Buttons

You may add additional buttons, such as Back, Forward, Home, Refresh, and Stop to your web browser. Just create a button and animate it with one of the following Touch Push button action scripts, depending on the type of button you want (use the ActiveX Control Browser from the Insert/ActiveX menu option):

	Back button:
	#Explorer1.GoBack();

	Forward button: 
	#Explorer1.GoForward();

	Home button: 
	#Explorer1.GoHome();

	Refresh button: 
	#Explorer1.Refresh();

	Stop button:
	#Explorer1.Stop();


Finishing Touches

You can add additional cosmetic elements to complete the perfect browser. For example, you can capture the graphic that is used for the toolbar in Microsoft Internet Explorer and use it as a transparent image over the Back, Forward, Stop, and Refresh buttons you just created. To do this, launch Microsoft Internet Explorer, make sure it is maximized, and then press <ALT> + <Print Screen> on your keyboard to capture the window. Next, open Microsoft Paint (or another bitmap editor), paste the graphic, and then cut the toolbar out of the window. Go back to WindowMaker and create a bitmap object using the bitmap tool. Then paste the bitmap and resize it. To use your newly created buttons with the toolbar, layer the buttons under the toolbar so that each button is under its respective image on the toolbar. Be sure to align them well. In runtime, you will be able to use the buttons on the toolbar. With a little effort, you could make your window look almost exactly like Microsoft Internet Explorer.

M. McCulty
The Tech Note is published occasionally by Wonderware Technical Support. Publisher: Invensys Systems, Inc., 26561 Rancho Parkway South, Lake Forest, CA 92630.  There is also technical information on our software products at www.wonderware.com/support/mmi
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For technical support questions, send an e-mail to support@wonderware.com.
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